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1. NSLDS Gainful Employment Debt-to-Earnings Backup Data Viewer 
Introduction 
The Department of Education releases Gainful Employment (GE) Debt-to-Earnings 
rates on an annual basis. The supporting records are provided to institutions in the 
GE Debt Measures Backup Data file that contains students who were included in the 
Debt-to-Earnings calculation for the current calculation year. This list is created from 
data provided by your school, matched with SSA, and then matched with NSLDS loan 
and enrollment data. The initial file is the Draft GE Debt-to-Earnings calculation. You 
may challenge the loan data, associated with your student and their attendance in a 
specific Gainful Employment program. Challenges may be submitted for individual 
loans found in your GE Debt Measures Backup within the designated time period, 
and are adjudicated by the Department; after which Final GE Debt-to-Earnings rates 
are calculated. 

NSLDS has created a tool that will assist you in viewing your Gainful Employment 
Debt Measures Backup Data file for the Debt-to-Earnings rate calculation. The 
following set of instructions will explain the features of the tool, how to open your 
file in the tool, and how to view your student, program, and loan data. 

Remember: Challenges are not submitted via the Viewer tool. This is tool is for the 
purpose of data review only. 

2. Getting Started 
Saving Software 

Obtain software by right clicking on the link in the GE Resources page and saving it 
in a secure manner on your local machine or network. The software will need to be 
able to access the Gainful Employment Debt Measures Backup Data files sent via 
SAIG, so they should either be saved on the same computer or within the same 
secure network. 

Once the software has been downloaded from IFAP, and the GE Debt Measures 
Backup Data downloaded from your SAIG mailbox, you are ready to begin by 
clicking on the software.  Note: You will need to have JavaTM in order to use this 
software. 

The software will open and the screen below will appear. 
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Select the Browse button to locate the GE Debt Measures Backup Data file. This file 
can either be the file that was pushed to your SAIG mailbox or the one requested via 
report GEDMY1. Both files utilize the same format. For more information regarding 
the file format, please see the Gainful Employment User Guide. 
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After selecting the Browse button, use the Browse function to search for the Debt 
Measures Backup Data file, and click Open. Should a file that is not the correct file be 
selected, you will receive a message that indicates that the file is not valid. Simply 
select the Browse button again and use the Browse function to search for the 
correct file. 

 

 
 

You will know that you have located the correct file when the OPEID and name of 
your school appear below the Input File Name box. Click Open and the software will 
initiate.  

Note: When returning to the software after your initial session, you will not have to 
browse and locate the file. 

 

<<NON-DEBT MEASURES FILE FROM YOUR COMPUTER>> 
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3. Getting to Know the GE Debt-to-Earnings Viewer 
Once you have located and opened your GE Debt Measures Backup Data file, you are 
ready to begin viewing the data. There are two distinct ways of viewing the data in 
the Viewer. The first is by Program/Student. The second is by Student/Program. You 
can switch between views by clicking the Switch button. Each view has the same 
Filter sections, which utilize the same functions. 

<<VALID DEBT MEASURES FILE>> 
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Menu Bar Overview 

Several features unique to the Viewer are available under the File menu item. You 
can use the Open function to go back to the Open screen allowing you to select a 
new file, or use the Export to Spreadsheet feature to create a spreadsheet of your 
GE Debt Measures Backup Data. You can also use the Exit option to close the 
software. 

 
 

See Chapter 5 for detailed information regarding the Export to Spreadsheet feature. 
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Various customizations can be made to the tool prior to use. Under the Options 
menu item you can alter the way dates are presented under Date Format. CCYY-
MM-DD is the default presentation for all dates. 
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By selecting MM/DD/CCYY all dates within the Viewer will be converted to this 
format. (Note: this is for viewing purposes only, the data within the GE Debt 
Measures Backup Data file is not altered when this Option is used.) 

 
 

Also under the Options menu item is the ability to determine which files are opened, 
under Open Prior File at Start. In the event that you will be using the GEDMY1 
report to review your records, rather than the “pushed” file, this option will allow you 
to receive the Open box each time you start the software, and allow you to select a 
different file to work with. The default for this feature is No, allowing the most 
recently opened file to automatically be used, rather than selected. 

Under the Help menu item are the Help Contents, GE Support, and Technical 
Support. Each of these items will provide you with reference information regarding 
the tool, or who to contact for a variety of different types of questions. 
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Filter Section Overview 

The Filter section of the tool contains multiple areas which are designed to help you 
narrow down your search when looking for records in your GE Debt-to-Earnings 
Backup Detail file. The Filter section is divided up into three areas: main Filter section, 
Program section and the Student section. 
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Filter Section Details 

Upper Right Corner – Minus button collapses the entire Filter section to allow for 
more space on the screen to review data. 

 
 

Bottom Left Corner – List of all filters selected will be present. None will appear prior 
to selecting any filters. 
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Bottom Right Corner – Sort: SSN/Name/Amount. SSN is the default sort option for 
records in the Students section. 

 
 

CIP Code Box – Enter a CIP Code from the file to search the Program section. The list 
will be dynamically sorted as you type. 
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Credential Level – List of Credential Levels for programs found in your Debt Measures 
Backup Data. As such, it’s possible that the list may contain fewer than all of the 
levels possible. 

A Credential Level can be selected by clicking on one with your mouse. Hold down 
the CNTL key and click each Credential Level to select multiples. Use CNTL click to 
de-select from the list. 
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Program Section Details 
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Evaluation Result – List of Evaluation Results for programs found in your Debt 
Measures Backup Data file. As such, it’s possible that the list may contain one or 
more of these values. Too small indicates that a program was too small for 
evaluation. 
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Transitional Rate– This field conducts a search of the Transitional Rate Earnings Flag 
fields and produces results based on the contents of the field. ‘Used’ yields those 
programs for which the Transitional Rate is the basis of the evaluation. ‘Calculated’ 
yields those programs which have a Transitional Rate in the Debt Measures Backup 
Data file. The Programs list will be dynamically sorted. These are the ‘Transitional 
Debt-To-Earnings Annual Pass/Zone/Fail’ and ‘Transitional Debt-To-Earnings with 
Discretionary Income Pass/Zone/Fail’ data elements from the GE Debt Measures 
Backup Data. 
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Student Section Details 
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Qualifying Term – Checkboxes allow you to select whether or not to be presented 
with records which were considered as part of a transitional rate by selecting Exclude 
Transitional Rates, or to Include Only Transitional. Leaving these boxes blank will 
produce all records, regardless of rate type. The Students list will be dynamically 
sorted as you make selections. 
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SSA Match Limit Exclusion – This field indicates whether or not a student has been 
excluded from the calculation based on information returned from SSA. The valid 
values are Yes and No. The Students list will be dynamically sorted as you make 
selections. 

 
 

Higher Cred Level (Trans Only) - This field indicates whether or not a student has 
been excluded from the calculation based on information regarding a Higher 
Credential Level program. The valid values are Yes and No. The Students list will be 
dynamically sorted as you make selections. 
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Programs Section Details 

 
The count next to the Programs table heading is equal to the number of programs in 
the table, based on the filter criteria currently selected. 

 

CIP Code – This is the CIP Code of the program as reported by the school. 
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Cred Level – This is the Credential Level Code of the program as reported by the 
school. 

 
 

Program Name – This is the official CIP Program name associated with the reported 
CIP Code. 
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Annl Earn Flag – This is the Debt-to-Earnings Annual Pass/Zone/Fail field. Space in 
this field indicates the program was too small for evaluation. 

 
 

Annl Earn Rate – The Debt-to-Earnings Annual Rate calculated for this program. N/A 
is displayed for programs which were too small for evaluation. 
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Discr Incm Flag – This is the Debt-to-Earnings with Discretionary Income 
Pass/Zone/Fail field. Space in this field indicates the program was too small for 
evaluation. 

 
 

Discr Incm Rate – The Debt-to-Earnings with Discretionary Income Rate calculated 
for this program. N/A is displayed for programs which were too small for evaluation. 
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Tran Annl Earn Flag – This is the Transitional Debt-to-Earnings Annual 
Pass/Zone/Fail field. Space in this field indicates the program was too small for 

evaluation. 

 
 

Tran Annl Earn Rate – The Transitional Debt-to-Earnings Annual Rate calculated for 
this program. N/A is displayed for programs which were too small for evaluation. 
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Tran Discr Incm Flag – This is the Debt-to-Earnings with Discretionary Income 
Pass/Zone/Fail field. Space in this field indicates the program was too small for 
evaluation. 

 
 

Tran Discr Incm Rate – The Debt-to-Earnings with Discretionary Income Rate 
calculated for this program. N/A is displayed for programs which were too small for 
evaluation. 
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Students Section Details 

 
 

Count – This field contains the total count of students in the Debt measures Backup 
Data utilized for the rate evaluation of this program. 
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SSN – The Social Security Number of the student as provided by the school. 

 
 

Name (Last, First, Middle) – The name of the student. 

 
 

26 
 



Date of Birth – The date of birth of the student. 

 
 

Qual Term – This field indicates which qualifying term the student is included. 
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Excl Rsn– This field indicates whether or not the student has been excluded from the 
evaluation. 

 
 

Debt Amt – This field provides the total debt for the student. 
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Title 4 Debt – This field provides the Title IV loan debt attributed to attendance in 
this GE program. 

 
 

Private Debt – This field provides the private loan debt as reported by the school. 
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Institution Debt – This field provides the institutional debt as reported by the school. 

 
 

Tuition And Fees – This field provides the tuition and fees as reported by the school. 
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Allow Bks, Supp – This field provides the Allowance for Books, Supplies, and 
Equipment as reported by the school. 

 
 

 

TIP: Rearrange Columns 

By clicking and dragging a column within a table, you are able to reorder the 
columns within that table. 
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When the column is where you want it, release the mouse button. This feature allows 
you to reorder the columns within a single table to give you different views of data. 

 
Note: You can’t remove, hide or delete columns in a table. Nor can you move a 
column between tables with this feature. 
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4. Possible Search Methods 
There are multiple ways to dissect the information included in your Debt Measures 
Backup Data and there are several search options are available to help you do so.  
These include the ‘Jump’ feature and Program/Student and Student/Program views. 

 

 
Jump Feature 

The Jump feature provides you with the ability to jump to a particular student in your 
Debt Measures Backup Data file.  In order to jump, you must have the exact 
combination of CIP Code, CL, and the Student’s ID (without spaces).  The Student ID 
is not the student’s social security number, but a unique alpha numeric field used to 
identify a specific student in a specific program’s calculation. 
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Program/Student Option 

A. By Program 
1. Determine which program is going to be examined and select it. 
2. Students contained in Debt Measures Backup Data for that program will 

populate the Students box once the Program is selected. 
3. Filter criteria for Qualifying Term can be used to pare down the data for 

further analysis. 
4. Click on a row in the Student box to see the information for that student 

found in the GE Debt Measures Backup Data file. 
 
 

B. By Credential Level 
1. Select Credential Level from Filter. 
2. All Programs with that Credential Level will appear in the Programs box 

beneath. 
3. Filter criteria for Program can be used to pare down the data for further 

analysis. 
4. Determine which program is going to be examined and select it. 
5. Students contained in GE Debt Measures Backup Data file for that program 

will populate the Students box once the Program is selected. 
6. Filter criteria for Student can be used to pare down the data for further 

analysis. 
7. Click on a row in the Student box to see the information for that student 

found in the GE Debt Measures Backup Data file. 
 
 

C. By CIP Code 
1. Enter the CIP Code for a Program found in the GE Debt Measures Backup 

Data file. 
2. The Programs list will begin to filter upon entry of the first digit entered into 

the box. Note: not all digits have to be entered to receive results. 
3. Filter criteria for Program can be used to pare down the data for further 

analysis. 
4. Determine which program is going to be examined and select it. 
5. Students contained in GE Debt Measures Backup Data file for that program 

will populate the Students box once the Program is selected. 
6. Filter criteria for Student can be used to pare down the data for further 

analysis. 
7. Click on a row in the Student box to see the information for that student 

found in the GE Debt Measures Backup Data file. 
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Student/Program Option 

A. By Student 
1. Determine which student is going to be examined and select it. 
2. Programs contained in Debt Measures Backup Data for that student will 

populate the Student’s Program(s) box once the Student is selected. 
 
 

B. By Credential Level 
1. Select Credential Level from Filter. 
2. All Students with that Credential Level will appear in the Students box 

beneath. 
3. Filter criteria for Program can be used to pare down the data for further 

analysis. 
4. Determine which student is going to be examined and select it. 
 
 

C. By CIP Code 
1. Enter the CIP Code for a Program found in the GE Debt Measures Backup 

Data file. 
2. The Students list will begin to filter upon entry of the first digit entered into 

the box. Note: not all digits have to be entered to receive results. 
3. Filter criteria for Program can be used to pare down the data for further 

analysis. 
4. Filter criteria for Student can be used to pare down the data for further 

analysis. 
5. Click on a row in the Student box to see the information for that student 

found in the GE Debt Measures Backup Data file.  
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5. Export to Spreadsheet 
NSLDS has created a function within the GE Debt-to-Earnings Viewer tool that will 
allow you to export your Gainful Employment Debt Measures Backup Data file to a 
spreadsheet. 

 
 

Selecting the Export to Spreadsheet option opens a window in which you can 
request the export. 
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The Browse button will allow you to search for a folder in which the export is to be 
stored upon execution. The folder must already be created in order for the Browse 
feature to locate it. 

 
 

Note: this folder name is an example ONLY and the tool does not require the folder 
to follow this naming convention. 
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You do not have to use the browse feature. If you happen to know the name of the 
directory, it can be typed directly into the Spreadsheet Name field. However, should 
a non-existent directory be typed, you will receive a message that indicates that the 
Target Directory does not exist. 

 
 

Simply select the Browse button again and use the Browse function to search for the 
correct directory, or correct the directory name by typing.  

Once the directory name is accurate, you will need to create a name for the 
spreadsheet file to be created under. There are no restrictions to the naming 
convention of the spreadsheet, aside from those that currently exist on your 
computer. Once a valid name is entered into the dialogue box, the message Click on 
Export button to proceed will be visible. 
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At this point you are ready to export your file by clicking on Export. In the event that 
you do longer to desire to export the data Cancel will close the Spreadsheet Export 
window. 

Once the export has been created to the requested directory an informational 
message will appear informing you that the export has completed. 

 

 
 

Once the message is visible click OK to close the dialogue box, and proceed to the 
directory on your computer to view the exported spreadsheet. 

Note: The spreadsheet will NOT automatically open on your desktop once the export 
has been completed, nor will the spreadsheet software. You have to go to the 
directory that was previously identified and click on the file. 
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Clicking on the file name opens the spreadsheet software you have defined for the 
xlsx file extension and the spreadsheet file. 

All record types in the GE Debt Measures are not used in the evaluation of the GE 
Debt-to-Earnings rates. Some of them are there for the GE Debt-to-Earnings 
evaluation. These record types, while they appear in the GE Debt Measures Backup 
Data file, are not present in the spreadsheet export. Only record types utilized in the 
rate evaluation will be present in the file. There is also no trailer record present in the 
export. 

Columns indicated as Filler are also not present in the file. For more information on 
these columns, please refer to Appendix D the Gainful Employment User Guide 
found on the Information for Financial Aid Professionals website under Resources. 
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https://ifap.ed.gov/GainfulEmploymentInfo/GEResourcesV2.html


 
 

Standard spreadsheet functionality is used to present the exported file: a single worksheet per record type, column 
heading to describe the content, and mouseover hints to assist with the definition of each field. 

 

 
 

 
 



NSLDS has added the SSN to the end of the following Record Types in the spreadsheet 
export: 

• GE Record (15) 
• Loan Record (20) 
• Loan other GE Record (25) 
• Loan Enrollment Record (35) 

This variation from the file layout is added for the convenience of those who may like to 
import the results of the spreadsheet export into a database tool such as Access or 
other database tool. This field will allow you to link the record types together. 
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